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SUMMARY
Intestinal epithelium regeneration and homeostasis must be tightly regulated. Alteration of epithelial homeo-
stasis is a major contributing factor to diseases such as colorectal cancer and inflammatory bowel diseases.
Many pathways involved in epithelial regeneration have been identified, but more regulators remain undis-
covered. Metabolism has emerged as an overlooked regulator of intestinal epithelium homeostasis. Using
the model organism Drosophila melanogaster, we found that ether lipids metabolism is required to maintain
intestinal epithelial homeostasis. Its dysregulation in intestinal progenitors causes the activation of the
unfolded protein response of the endoplasmic reticulum (UPR) that triggers Xbp1 and upregulates the
conserved disulfide isomerase PDIA3/ERp60. Activation of the Xbp1-ERp60 signaling causes Jak/Stat-medi-
ated increase in progenitor cells, compromising epithelial barrier function and survival in males but not fe-
males. This study identified ether lipids-PDIA3/ERp60 as a key regulator of intestinal progenitor homeostasis
in health that, if altered, causes pathological conditions in the intestinal epithelium.
INTRODUCTION

All epithelial layers need to preserve homeostasis to execute

their function and maintain a healthy physiological status.

Epithelial homeostasis is achieved by the precise balance of

epithelial stem cell/progenitor (PG) proliferation and differentia-

tion. The intestinal epithelium is the largest epithelium of the

body.1,2 It can digest and absorb nutrients and promote endo-

crine and immune regulation while keeping a healthy relationship

with the beneficial commensals. The intestinal epithelium has a

limited lifespan of about 4–5 days, and it has to be constantly re-

plenished to prevent disruption of the barrier function. Intestinal

stem cells (ISCs) continuously self-renew and give rise to enter-

oblasts (EB) that can go through differentiation to originate

specialized absorptive or secretory epithelial cells and maintain

intestinal epithelium functions.3 Intrinsic pressures from genetic

or epigenetic sources and extrinsic pressures imposed by path-

ogens, commensals, or xenobiotic insults can disrupt epithelial

homeostasis,4–7 promoting excessive proliferation and driving

diseases such as inflammatory bowel disease and colorectal

cancer.8

To date, many signaling pathways that regulate ISC homeo-

stasis, such asWingless-related integration site (WNT), Janus ki-

nase/signal transducers and activators of transcription (JAK/
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STAT), Hippo pathway (Hpo), Notch signaling, epidermal growth

factor receptor (EGFR), insulin receptor signaling (InRs), and

Hedgehog (Hh) signaling, have been identified in Drosophila

and mammals.6,9–12 Although these studies have deepened

our understanding of the complex mechanisms of ISC homeo-

stasis, many more pathways remain to be explored. Metabolic

regulation of the ISC niche in physiological conditions and under

stress has emerged as a crucial regulator of ISC proliferation and

differentiation and as an integrator of environmental cues13–15

that impact ISC homeostasis. For instance, increased glycolysis

and mitochondrial fatty acid oxidation promote stem cell activa-

tion in healthy and injured states.16,17 It was demonstrated in

Drosophila and mammals that the mitochondrial tricarboxylic

acid (TCA) cycle, oxidative phosphorylation (OXPHOS) pathway,

and ATP production support the proliferation of ISC under regen-

erative stimuli18–20 and in murine models of intestinal inflamma-

tory conditions.21 Moreover, a cross-talk between glycolysis

and mitochondrial fatty acid b-oxidation regulates the EGFR-

mediated ISC division and differentiation in Drosophila,22 and

fatty acid oxidation is required for survival and renewal of the in-

testinal epithelium in mice,23 highlighting the important role of

mitochondrial metabolism in ISC differentiation.

Cellular metabolism is orchestrated by controlled synergy be-

tween organelles.24 Recent studies suggest that organelles such
rch 21, 2025 ª 2025 The Author(s). Published by Elsevier Inc. 1
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Figure 1. Depletion of Pex5 in progenitor cells leads to the upregulation of ER-stress response ERp60 and an increase in esg+ cells in adult

guts

(A) Representative images showing esgGFP (green) cells in Drosophila female and male adult posterior midgut regions of esgGFP>w1118 control strain and

esgGFP>Pex5-i strain with dysfunctional peroxisomes in progenitor cells. Scale bar, 20 mm.

(B and C) The dot plots represent the number of esgGFP cells per region of interest (ROI) in (B) female or (C) male adult posterior midguts of flies of the reported

genotypes. n = 15–35.

(legend continued on next page)
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as the endoplasmic reticulum (ER) and peroxisome also directly

regulate signaling that controls ISC proliferation through their

metabolism.25

Most studies have characterized glycolysis and mitochondrial

metabolism directing ISC homeostasis, whereas much less is

known about the role of other organelles and their metabolism

in ISC regulation.

Using the genetically sophisticated model organism

Drosophila melanogaster, a proven valuable model organism to

identify mechanisms controlling ISC homeostasis in health and

diseases,3,26 we investigated the role of peroxisomal meta-

bolism in controlling ISC homeostasis. Peroxisomes are essen-

tial metabolic organelles present virtually in every eukaryotic

cell and the only site where very long-chain fatty acid (VLCFA)

b-oxidation, a-oxidation of branched-chain fatty acids, and syn-

thesis of ether lipid precursors occur.27 Genetic mutations that

affect genes encoding for the so-called Peroxins (Pex) involved

in peroxisomal biogenesis and function lead to cellular metabolic

dysfunctions in all eukaryotes.28 Previous evidence has shown

that RNA interference (RNAi)-mediated depletion of Peroxin5

(Pex5) in PGs10 results in the increased proliferation and accu-

mulation of PGs in the posterior midguts of adult Drosophila un-

der physiological conditions29 and in the presence of oxidative

stress.30

Here, we demonstrate that the reduction of peroxisomal ether

lipid metabolism prompts the ER stress response in PGs and

triggers the unfolded protein response (UPR)31,32 to drive excess

PG proliferation in the attempt to restore intestinal epithelial

homeostasis. Ether lipids are essential components of every bio-

membrane, and their synthesis happens between the peroxi-

some and the ER.33 Alteration of lipid metabolism can trigger

ER stress34,35 in stem cells,36 and UPR activation was previously

linked to intestinal homeostasis in Drosophila melanogaster.37,38

ER stress is sensed by the three main ER sensor proteins in

Drosophila as in mammalian cells: inositol-requiring enzyme 1

(IRE1), protein kinase R (PKR)-like ER kinase (PERK), and acti-

vating transcription factor 6 (ATF6). Upon ER stress, each protein

controls distinct branches of UPR that regulate unique transcrip-

tional or translational programs,39,40 alleviating ER stress primar-

ily via three mechanisms.41 These mechanisms aim to (1) in-

crease the protein-folding capacity of the ER by inducing the

transcription of various genes encoding molecular chaperones

and folding enzymes; (2) attenuate protein translation to reduce

the burden on ER; and (3) transport misfolded proteins from the

ER back to the cytosol, for degradation by the proteasome, a

process called ER-associated protein degradation (ERAD).

Previous research reported that peroxisomal dysfunction in

murine globalPex2�/� knockout drives ER stress response in he-
(D) The bar graph represents the relative expression of ERp60 transcript versus

(E) The bar graph represents the relative expression of ERp60 transcript versus R

(F and G) The dot plots represent the number of esgGFP cells per ROI in the poster

(H) Fluorescent microscopic images showing esgGFP cells (green) in midgut regi

genotypes. Scale bar, 50 mm.

(I and J) Select GSEA of differentially expressed genes in esgGFP>Pex5-i versu

significantly enriched in functional categories of (I) ubiquitin-dependent ERAD p

stained with DAPI (blue). The error bars represent the standard deviation of the

(E) and one-way ANOVA tests in (B, C, F, and G). ****p < 0.0001; **p < 0.01; *p <
patic cells, leading to PERK activation and deregulation of sterol

metabolism.42,43 However, why peroxisomal dysfunction drives

the ER stress response was not mechanistically defined, nor

was the activation of the other sensors of the UPR in hepatic cells

or any other cell or organism.

We found that alteration of peroxisomal ether phospholipid

metabolism stalls the production of phospholipid species essen-

tial for the cells, triggering the Xbp1 branch of the UPR

response.44 Xbp1 drives the expression of ERp60, the ortholog

of protein disulfide isomerase A3 (PDIA3), a pleiotropic member

of the PDIs family involved in protein folding.45 PDIA3 has been

implicated in the regulation of various cellular signaling in the

ER and other cellular compartments, including the nucleus, the

plasma membrane, and mitochondria,45 controlling many phys-

iological and pathological signaling.45–48 We demonstrated that

ERp60 is a regulator of PG homeostasis and responds to ether

lipid metabolic shifts.

Our data provide evidence of an inter-talk between peroxi-

some and ER lipid metabolism to control ISC homeostasis and

intestinal regeneration. Considering the importance of meta-

bolism and UPR response in cancer and intestinal inflammatory

diseases,49 the discovery of a peroxisome-ER-ether lipid-ERp60

axis opens avenues of exploration for future interventions to con-

trol cancer and chronic intestinal inflammation.

RESULTS

Depletion of Pex5 in Drosophila intestinal progenitor
cells leads to the activation of ERp60, a novel regulator
of PG cell number
Pex5 encodes for a cytoplasmic receptor needed to form meta-

bolically functional peroxisomes.50 We previously reported that

the depletion of Pex5 by in vivo RNA interference (RNAi) in intes-

tinal PG (ISC and EB) increased the number of midgut PG in adult

female and male flies due to accelerated PG proliferation as

demonstrated by an increase in phospho-histone3 (PH3), a spe-

cific marker for mitotic cells.29 This increase in PG cells did not

affect differentiation as the ratio of enterocytes (EC) to enteroen-

docrine cells (EE) did not change compared to what was

observed in control age-matched guts.29 To determine how

peroxisomal dysfunction leads to a significant increase in PG

proliferation (Figures 1A–1C), we performed RNA sequencing

(RNAseq) of intestinal PG isolated by fluorescence-activated

cell sorting (FACS) from the midguts of 10-day-old pooled

male and female adult flies (Figure S1A). We used flies

encoding the esgGal4,UAS-GFP;tub-Gal80ts (esgGFP) driver10

and compared the transcriptional profiles of PG from a control

strain (esgGFP>w1118) to the Pex5 RNAi strain (esgGFP>Pex5-i),
Rpl23 in esgGFP>w1118 and esgGFP>Pex5-i female adult midguts. n = 6.

pl23 in esgGFP>w1118 and esgGFP>Pex5-i male adult midguts. n = 3.

ior midguts of (F) female or (G) male flies of the reported genotypes. n = 15–20.

ons of adult female (top panels) and male (bottom panel) flies of the reported

s esgGFP>w1118 progenitors from adult male and female intestines that were

athway and (J) response to unfolded proteins. In every image, the DNA was

mean. Statistical significance was calculated using unpaired t tests in (D) and

0.05; ns, not significant. See also Figures S1 and S2.
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which has reduced peroxisomal activity due to the depletion of

Pex5 (Figure S1B).

We selected 89 genes that exhibited significant differential

gene expression between the PG of esgGFP>Pex5-i and

esgGFP>w1118 flies (Table S1) and had known linkage to peroxi-

somal associated processes, such as response to redox51 and

cytoskeleton remodeling,52 or exhibited a highly PG-specific

expression pattern as reported on Flygut-seq53 but have not

been fully functionally characterized or have no known function

in intestinal PG maintenance or proliferation (Table S1).

Among genes validated to be differentially expressed in male

and female esgGFP>Pex5-i compared to sex- and age-matched

esgGFP>w1118 guts was the gene ERp60. Quantitative real-time

PCR (RT-qPCR) analyses showed upregulation of ERp60 in

esgGFP>Pex5-i compared to esgGFP>w1118 midguts (Figures 1D

and 1E) in agreement with our transcriptomic results

(Figure S1C).

To test if ERp60 was associated with the increase in PG num-

ber observed in esgGFP>Pex5-i (Figures 1A–1C), we assessed

PG cell number upon ERp60 overexpression or depletion by

two different RNAi lines (Figures S1D, S1F, and S1G). We used

the conditional esgGFP driver to express dsRNA targeting

ERp60 or to overexpress ERp60 cDNA. Conditional expression

was initiated from the larval stage onward, and the number of

GFP-positive PG cells in the midgut regions of 10-day-old

male and female flies was analyzed by fluorescencemicroscopy.

The age was determined based on when an increase in PG

numbers was detected in esgGFP>Pex5-i flies. Analysis of the

posterior midgut regions showed that overexpression of

ERp60 led to an increase in PG in both males and females

(Figures 1F–1H). On the other end, RNAi-mediated depletion of

ERp60 using two independent RNA lines led to a reduction of

PG in the posterior midguts of male and female flies compared

to age-matched esgGFP>w1118 control flies (Figures 1F–1H). In

conclusion, we confirmed that the ERp60 gene is upregulated

in PGwith nonfunctional peroxisomes, and genetic manipulation

of ERp60 suggested that it regulates PG number in the posterior

midguts of male and female adult flies.

Depletion of Pex5 in progenitor cells leads to the
upregulation of ER-stress response
To understand which cellular processes were associated with

ERp60 and the increase in midgut PG number in esgGFP>Pex5-i

flies, we analyzed our transcriptomic data using gene set enrich-

ment analysis (GSEA) and Cytoscape.54 This analysis highlighted

changes in cellular processes previously reported to be altered in

tissues with dysfunctional peroxisomes in Drosophila52 and

mammals,55,56 including changes in carbohydrate andmitochon-

drial metabolism, responses to oxidative stress, lipids catabolism

(e.g., peroxisomal b-oxidation), sphingolipid metabolic pro-

cesses, and processes of glycerolipid and glycerophospholipid

catabolism (Figure S2; Table S1), confirming the reliability of our

screen. Additionally, the most differentially expressed genes in

esgGFP>Pex5-i versus esgGFP>w1118 were involved in cytoskel-

eton regulation and immune signaling, both processes known

to be regulated by peroxisome metabolism29,52,57 (Figure S2). In

agreement with the increase in PG number observed in esgGFP>

Pex5-i, we found the enrichment and clustering of the topmost
4 iScience 28, 111946, March 21, 2025
differentially expressed genes belonged to processes of cell divi-

sion, stem cell maintenance, and regulation of various signaling

pathways that have established roles in PG maintenance, divi-

sion, and differentiation such as Jak/Stat pathway, EGFR

signaling,Wingless,Hpo, andNotchpathways5,10,58,59 (FigureS2;

Table S1).

Our GSEA and Cytoscape transcriptomic analyses also

identified ER stress response as a significantly enriched

process in esgGFP>Pex5-i PG (Figures 1I, 1J, and S2). This

included the endoplasmic-reticulum-associated degradation

(ERAD) pathway60 and cellular response to unfolded protein

(UPR)61 (Figures 1I, 1J, and S2; Table S1).

It was reported that defects in peroxisome biogenesis could

trigger ER stress through the PERK-eIF2a branch of the

UPR.43,62 What remains unknown is whether other branches of

the UPR respond to peroxisomal dysfunction, how peroxisome

dysfunction prompts the UPR, and how UPR signaling regulates

intestinal stem cell identity, differentiation, and tissue homeosta-

sis.37,38,63 The marked involvement of these processes in PG

increase in response to dysfunctional peroxisomes was notable

as ERp60 encodes a protein disulfide-isomerase ortholog of the

human PDIA3 (protein disulfide isomerase family A member 3)

involved in protein folding and response to endoplasmic reticu-

lum stress and part of the UPR.45,64

Since we found that ERp60, a target of the transcription factor

Xbp-1 of the UPR pathway, is upregulated in esgGFP>Pex5-i in

midguts from male and female adult flies (Figures 1D, 1E, and

S1C) and ERp60 overexpression in PG using the esgGFP driver

in control flies (Figure S1D) increased the number of midgut

PG (Figures 1F–1H), we decided to investigate further how

ERp60 controls PG numbers in the posterior midgut.

ERp60 controls PG proliferation but does not impact
differentiation in esgGFP>Pex5-i posterior midguts
Toconfirm that the elevatedexpressionof ERp60observedduring

thePGperoxisomedeficiency ofesgGFP>Pex5-i flies is associated

with the increasedmidgut PGnumber of these flies,wegenetically

depleted ERp60 transcript in esgGFP>Pex5-i flies. Fluorescent

microscopic analysis showed that ERp60 depletion significantly

reduces PG number in esgGFP>Pex5-i midguts to the level

observed in esgGFP>w1118 posterior midguts (Figures 1F–1H and

S1H). These findings show that the change in PG number

correlates to changes in ERp60 or Pex5 transcript in the analyzed

genotypes. Interestingly, we found that depletion of Pex5 in enter-

ocytes using the driver MexGal465 did not show induction of

ERp60 (Figure S1E), suggesting that this might be a PG-specific

response to peroxisomal dysfunction.

To determine if ERp60 control of PG number occurs during

development or also during adult stage, we used the conditional

temperature-sensitive Gal4 activation of the esgGFP driver line

and performed gene manipulations in PG by shifting the esgGFP>

Pex5-i, esgGFP>ERp60-i or esgGFP>ERp60OE to the permissive

temperature after eclosion. We found that the number of PG cells

increased in esgGFP>w1118 guts when the flies were shifted from

18oC to 29oC and stayed high up to 14 days after the transfer (Fig-

ure S1I). Additionally, PG numbers were significantly higher in

esgGFP>Pex5-i or esgGFP>ERp60OE when adult flies were shifted

to 29oC at eclosion and dissected after 14 days but were reduced
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considerably in 14-day-oldmidguts ofesgGFP>ERp60-i compared

with 3-day-old esgGFP>ERp60-i and compared to the number

observed in the midguts of esgGFP>w1118 kept at 29oC for

14 days (Figures S1I–S1L).

We performed immunofluorescence (IF) experiments followed

by confocal microscopy analyses to evaluate whether the

change in PG cell number observed in esgGFP>Pex5-i, esgGFP>

ERp60-i, and esgGFP>ERp60OE compared to esgGFP>w1118 pos-

terior midguts was caused by changes in proliferation or death

rate and whether it affected differentiation. Indirect IF studies

showed an increase in the number of cells positive for the prolif-

erative marker P-H337 in esgGFP>Pex5-i (as previously re-

ported29) and esgGFP>ERp60OE (Figure S3A) compared with

what observed in esgGFP>w1118 and esgGFP>ERp60-i posterior

midguts. On the other hand, indirect IF using the terminal deox-

ynucleotidyl transferase dUTP nick end labeling (TUNEL) stain-

ing to detect apoptosis revealed a higher level of cell death in

esgGFP>ERp60-i compared to esgGFP>w1118, esgGFP>ERp60OE,

and esgGFP>Pex5-i midguts (Figure S3B). Additionally, we found

a reduction in total cell number in the posterior midgut of 14-day-

old esgGFP>ERp60-i compared with esgGFP>w1118, esgGFP>

ERp60OE, and esgGFP>Pex5-i (Figure S3C).

Upon cell division, each ISC produces a daughter cell that re-

tains the ISC fateandapostmitoticEB thatdifferentiates intoeither

an absorptive enterocyte, EC, or a secretory enteroendocrine cell,

EE.5 Prospero is a homeodomain protein specifically expressed in

gut EEs.12 We observed no change in the number of Prospero-

expressing EEs over total number of cells in esgGFP>ERp60-i,

esgGFP>ERp60OE, and esgGFP>Pex5-i compared with control

esgGFP>w1118 midguts (Figure S3D). We concluded that ERp60

controlsPGnumberand is upregulated in response toperoxisome

dysfunction, leading to an increase in proliferation in the posterior

midguts in a sex-independent manner. This increase in PG does

not correlate with a change in differentiation.

Defects in peroxisomal ether lipid metabolism induced
overexpression of ERp60 and increase of PG
To determine which branch of peroxisomal metabolism triggers

the ERp60-mediated increase in PG, we probed the major

peroxisomal metabolic pathways using RNAi to deplete key en-

zymes of the VLCFA b-oxidation (peroxisomal acyl-coenzyme A

oxidase, Acox1), ether lipids synthesis (glyceronephosphate

O-acyltransferase, GNPAT), and redox clearance (Catalase,

Cat) (Figure S1M) and measure ERp60 transcript. We found an

upregulation of ERp60 in the midgut of both esgGFP>Acox1-i

and esgGFP>GNPAT-i flies relative to esgGFP>w1118 (Figures 2A

and 2B).

On the other hand, although biochemical measurements of hy-

droxide peroxide (H2O2) concentration showed an increase of

H2O2 in esgGFP>Cat-i and esgGFP>Pex5-i midguts compared

with esgGFP>w1118 (Figure S4A), the ERp60 transcript level did

not change in esgGFP>Cat-i compared with esgGFP>w1118 (Fig-

ure 2C). Thus, redox stress does not lead to the induction of

ERp60. Fluorescent microscopic analyses of the midguts of

male and female esgGFP>Acox1-i and esgGFP>GNPAT-i poste-

rior midguts exhibited an increase in PG cells compared with

esgGFP>w1118midguts in correlation with ERP60 overexpression

(Figures 2D–2H).
Defects in peroxisomal VLCFA b-oxidation cause accumula-

tion of free fatty acids (FFAs) in cells66 and tissues.67 A high-fat

diet (HFD) affects the metabolism of flies.68 It leads to the accu-

mulation of excess FFAs, similar to what is found in tissue with

peroxisome defects.29,67 FFAs are absorbed by the midguts,

transformed into neutral storage lipids such as triacyl glycerides,

and stored in lipid droplets throughout the midgut, with enrich-

ment found in sections of the anterior and posterior midgut re-

gions.69 We tested the effect of HFD on ERp60 expression in

adult flies fed an HFD enriched with VLCFs to mimic defects in

peroxisomal b-oxidation. We compared these flies with flies

fed on a balanced cornmeal diet (CMD). Microscopy data re-

vealed that although we observed an increase in PG in both

male and female esgGFP>w1118 (Figures 2I–2K) and accumulation

of lipid droplets in the posterior midguts of HFD-fed flies

(Figures S4B and S4C), RT-qPCR analyses did not detect an up-

regulation of ERp60 in esgGFP>w1118 fed on HFD versus CMD

(Figure S1D). These data suggest that ERp60-mediated

signaling in PG does not respond to FFA lipid stress but is spe-

cifically activated in response to dysfunction in peroxisomal lipid

metabolism. We treated the flies with niacin (vitamin B3), which

has been shown to reduce the amount of FFA in mam-

mals29,66,70,71 and Drosophila,52 a part having anti-oxidant ef-

fects.72,73 Biochemical analyses showed that treatment with

niacin was able to lower the amount of FFAs and H2O2 in

esgGFP>Pex5-i midguts to control levels, confirming his lipid

scavenger and anti-oxidant activity in Drosophila guts52,66

(Figures S4A and S4E). However, fluorescent microscopy ana-

lyses of esgGFP>w1118 and esgGFP>Pex5-i midguts showed that

treatment with niacin did not reduce PG number in esgGFP>

Pex5-i to numbers comparable to what was observed in

esgGFP>Pex5-i midguts in both males and females

(Figures S4F and S4G). Additionally, microscopy analyses

showed that esgGFP>ERp60-i fed HFD did not increase PG num-

ber in the posterior midguts compared to esgGFP>ERp60-i fed on

CMD, confirming that ERp60 does not respond to VLCFA lipo-

toxic stress caused by dysfunction in peroxisomal b-oxidation

(Figures S4H and S4I).

Together, these results confirmed that accumulation in VLCF

or redox species caused by defects in peroxisomal b-oxidation

or anti-oxidant activities do not trigger the increase in PG number

observed in esgGFP>Pex5-i midguts.

The first step in de novo ether lipid synthesis is mediated by

the peroxisomal enzyme glycerophosphate O-acyltransferase

(GNPAT), which has a strict substrate specificity reacting only

with the long-chain acyl-CoAs that can be imported from the

cytosol or produced intraperoxisomal by chain shortening of

CoA esters of VLCFA peroxisomal b-oxidation.74 AGPS subse-

quently catalyzes the substitution of the acyl chain with a long-

chain fatty alcohol, resulting in the formation of alkyl-DHAP

and the release of the fatty acid that is subsequently transported

to the ER, where the final steps of ether lipid synthesis occur.75

Since we observed an increase in PG in the midguts of flies

with metabolic ablation of the VLCFAs b-oxidation (esgGFP>

Acox1-i) guts and ether phospholipid pathways (esgGFP>

GNPAT-i), we probed whether the reduction in ether phospho-

lipids specifically triggers PG increase in esgGFP>Pex5-i.

GNPAT catalyzes the conversion of dihydroxyacetone
iScience 28, 111946, March 21, 2025 5



A B C

D E F

G H

I

J K

Figure 2. Deregulation of peroxisomal lipid metabolism triggers ERp60 upregulation in esg-positive cells and affects progenitors’ number

(A–C) The bar graphs show the ERp60 amount in the midguts of adult female (left) or male (right) flies of the reported genotypes. n = 3.

(D) Fluorescent microscopic analyses of esgGFP-positive cells in adult posterior midguts from female (upper panels) or male (lower panels) flies of the reported

genotypes. Scale bar, 10 mm.

(E–H) The dot plots represent the number of esgGFP-positive cells per ROI in adult posterior midguts of female (upper panels) esgGFP>w1118 and esgGFP>ACOX1-i

(E) and esgGFP>w1118 and esgGFP>GNPAT-i (F) ormale (lower panels) esgGFP>w1118 and esgGFP>ACOX1-i (G) and esgGFP>w1118 and esgGFP>GNPAT-i (H). n = 15–20.

(I) Representative images of fluorescent microscopy analyses indicating esgGFP-positive cells in posterior midgut regions of female (upper panels) or male (lower

panels) esgGFP>w1118 control flies fed a balanced cornmeal diet (CMD) or a cornmeal diet supplemented with 20% added fats (HFD; 4:1 coconut oil versus

broccoli oil). Scale bar, 20 mm. The dot plots represent the number of esgGFP-positive cells per ROI in adult posterior midguts of female (J) or male (K)

esgGFP>w1118 flies fed CMD or HFD. n = 5–30. In every image the DNA was stained by DAPI (blue). The error bars in (A–C), (E–H), and (J and K) represent the

standard deviation of the mean. Statistical significance was calculated using unpaired t tests. ****p < 0.0001; **p < 0.01; *p < 0.05; ns, not significant. See also

Figures S1 and S4.
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phosphate (DHAP) and acyl-CoA into acyl-DHAP and CoA. We

supplemented the diet of 3-day-old esgGFP>w1118 and

esgGFP>Pex5-i flies with an alkyl-DHAP, 1-O-Octadecyl-rac-

glycerol (batyl alcohol) for 4 days, and then we dissect the guts

and performed fluorescent microscopy analyses. Batyl alcohol

could rescue PG number in esgGFP>Pex5-i midguts to the num-

ber observed in esgGFP>w1118 midguts (Figures S5A and S5B).

Interestingly, adding batyl alcohol to the diet of esgGFP>w1118

and esgGFP>ERp60OEdid not impact PG number (Figures S5A

and S5B). These data suggest that ERp60 acts downstream of

plasmalogen synthesis.

Lipidomic analyses of esgGFP>Pex5-i midguts showed that the

amount of ether-phosphatidylethanolamine (PE) and ether-

phosphatidylcholine (PC) that are produced by peroxisomes

and can affect the total level of PE and PC were reduced in

esgGFP>Pex5-i midguts compared with control midguts

(Figures S5C and S5D).33 We also found that levels of PE and

PC core phospholipids, which are essential for membrane func-

tions and that are affected by peroxisomal ether lipids synthesis,

were reduced in esgGFP>Pex5-i midguts compared with

esgGFP>w1118 midguts76 (Figures S5E and S5F). We measured

the ratio of PC:PE, which is essential for biological membrane

function, including the ER membranes,77 and their ratio was

impacted (Figure S5G). Alteration of lipid composition in the

membrane has been shown to activate theUPR.78–81 Abnormally

high and low cellular PC/PE ratios were linked to misfolding of

membrane proteins and alteration of cellular signaling.77,82,83 In

conclusion, alteration in peroxisomal ether-phospholipid synthe-

sis appeared to cause changes in cellular amounts of major

lipids. This might explain the ER stress response activation de-

tected by the transcriptomic results and the increase in PG num-

ber in esgGFP>Pex5-i.

ERp60 regulates intestinal stem cell number and
controls tissue size
TheDrosophilaERp60 is the orthologous of humanPDIA3. PDIA3

is known to be localized mainly at the ER, where it participates in

correcting the folding of glycoprotein that needs to be localized to

the plasmamembrane or secreted. PDIA3 is activated by various

stresses (e.g., oxidative, metabolic), and it is also known to be a

transcriptional target of Xbp-1 of the UPR in response to ER

stress.44 PDIA3 was reported to regulate various cellular pro-

cesses, including cell growth and death and cell division, and

plays a role in cytokine-dependent signal transduction.46–48

To elucidate the role of ERp60 in PG regulation and

intestinal regeneration, we performed microscopy analyses of

intestines dissected from 3- or 14-day-old esgGFP>w1118 and

esgGFP>ERp60-i flies where the system was activated from

L1 stage.

We found that in 3-day-old flies, the esgGFP>ERp60-i intes-

tines were about the same size as age-matched esgGFP>w1118

(Figure 3A). On the other hand, esgGFP>ERp60-i intestines

were about three times smaller than age-matched esgGFP>w1118

in 14-day-old flies (Figure 3B), in agreement with a significant

reduction in PG number (Figures 1F–1H). We reported that

when the RNAi was activated at L1, we observed a

reduction of PG number in posterior midguts of 3-day-old adult

esgGFP>ERp60-i (Figures 1F–1H). Indirect IF experiments using
TUNEL staining to detect apoptosis revealed a higher level of

cell death in esgGFP>ERp60-i compared to esgGFP>w1118 and

esgGFP>Pex5-i midguts (Figures 3C and 3D) already at day 3

post-eclosion, before intestinal size was impacted. Moreover,

immunofluorescence analyses of midguts stained with the ISC

marker Delta indicated a loss of ISC and EB in esgGFP>ERp60-

i midguts (Figures 3E–3H), suggesting that ERp60 has a role in

both stem cell and EB survival.

Stem cell proliferation is regulated by ERp60
downstream of the Xbp1 branch of UPR and activated by
ER stress response
ERp60 is one of the genes induced by the UPR activated in

response to ER stress. Three highly conserved UPR sensors co-

ordinate the cell-autonomous response to ER stress: PERK, the

transcription factor ATF6, and the endoribonuclease IRE1. IRE1

promotes splicing of the mRNA encoding the transcription factor

Xbp1, PERK phosphorylates and inhibits the translation initiation

factor 2 alpha (eIF2a),37,38,84–86 and ER-stress-induced cleavage

of ATF6 promotes its nuclear translocation and activation of

stress response genes. The activation of Xbp1 and ATF6 results

in transcriptional induction of ER chaperones, of genes encoding

ER components, and of factors required to fold or degrade un/

misfolded proteins, thus enhancing ER folding capacity.37,87

ER stress and UPR are significantly enriched in the list of the

utmost differentially expressed genes in PG of esgGFP>Pex5-i

compared to esgGFP>w1118, and ERp60 is a target of Xbp1 and

contributes to the proteostatic tolerance of the UPR response.44

We wanted to validate which branch of the UPR was activated in

esgGFP>Pex5-i and whether its activation caused the ERp60-

induced increase in PG number in esgGFP>Pex5-i. To do this,

we probed the activation of the IRE1-Xbp1 branch of the UPR.

IRE1 activation in response to ER stress promotes an unconven-

tional splicing of the Xbp1 transcript. Xbp1 has a 23-nucleotide

intron that is removed from the transcript upon activation of

IRE1. We performed RT-PCR using primers that surround the

23-nucleotide intron region to probe for Xbp1 splicing,

measuring the amount of Xbp1 mRNA full length (240 base pairs

amplicon) or a short form (220 bp amplicon) in esgGFP>w1118 and

esgGFP>Pex5-i midguts. We could detect a strong signal for the

Xbp1 240 bp amplicon and aweak signal for the 220 bp amplicon

in esgGFP>w1118 samples conversely; we observed a fainter 240

and a stronger 220 bp amplicon in esgGFP>Pex5-i total RNA and

esgGFP>w1118 midgut total RNA extracted from dehydrated flies

(Figures 4A–4C) that acted as a positive control of ER stress.

To detect the activation of the ATF6 branch of the UPR, an in-

crease in the ATF6 transcript level is a reliable readout.32 We

measured ATF6 transcript level in esgGFP>Pex5-i compared to

esgGFP>w1118 midguts. RT-qPCR analyses did not identify any

significant change in ATF6 transcript level in the midguts of the

analyzed genotypes (Figure S6A), suggesting this branch of the

UPR was not activated in PG due to peroxisome dysfunction.

The other branch of the UPR, PERK-eIF2a, induces inhibition

of global translation, and its activation was found to regulate in-

testinal homeostasis in Drosophila.37 We probed whether this

branch of the UPRwas active in esgGFP>Pex5-i midguts. We per-

formed indirect immunofluorescent studies to investigate the

activation of eIF2 a, measured by the amount of phosphorylated
iScience 28, 111946, March 21, 2025 7



Figure 3. Deficiency in ether lipids metabolism increases progenitor numbers in esgGFP>Pex5-i midguts
(A) Image showing the side-by-side comparison of the length of the intestine of adult esgGFP>w1118 versus esgGFP>ERp60-i 3-day-old flies. Scale bar, 50 mm. The

graph bar reports the mean value of gut length in esgGFP>w1118 and esgGFP>ERp60-i flies. n = 20.

(B) Image showing the side-by-side comparison of the length of the intestine of adult esgGFP>w1118 versus esgGFP>ERp60-i 14-day-old flies. Scale bar, 50 mm.

The graph bar reports the mean value of gut length in esgGFP>w1118 and esgGFP>ERp60-i flies. n = 20.

(C) Fluorescent microscopic images indicating the esgGFP-cells (green) and TUNEL (red) in posterior midguts of esgGFP>w1118, esgGFP>Pex5-i, and

esgGFP>ERp60-i flies. Scale bar, 20 mm. Arrowheads indicate the esgGFP TUNEL double-positive cells.

(D) The graph bar reports the number of esgGFP-cells per ROI in esgGFP>w1118, esgGFP>Pex5-i, and esgGFP>ERp60-i posterior midguts. n = 10.

(E) Representative indirect immunofluorescent image indicating a reduction of Delta+ cells and esgGFP cells in posterior midgut regions of esgGFP>w1118 and

esgGFP>ERp60-i flies. Scale bar, 20 mm.

(F–H) The dot plots represent the number of Delta+ cells (F), esgGFP (G), and the ratio between Delta+ cells and esgGFP (H) per ROI in esgGFP>w1118 and

esgGFP>ERp60-i posterior midguts. n = 11–17. In every image the DNA was stained by DAPI (blue). The error bars represent the standard deviation of the mean.

Statistical significance in (C) was calculated using a one-way ANOVA test and in (A), (B), and (F–H) calculated using unpaired t tests. ****p < 0.0001; **p < 0.01;

*p < 0.05; ns, not significant. See also Figure S4.
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protein at serin 51. Confocal microscopy analyses showed an in-

crease in P-eIF2 a in esgGFP>Pex5-i compared with what was

observed in esgGFP>w1118 midguts (Figures 4D and 4E). These

data are in agreement with the downregulation of ribosomal

genes detected in the transcriptomic analyses (Figure S2) that

indicated reduced protein synthesis.
8 iScience 28, 111946, March 21, 2025
As eIF2a represents a convergence point of different stress

pathways,88 we checked the involvement of PERK-eIF2a

signaling branch in the increase in PG of esgGFP>Pex5-i mid-

guts by probing the PERK’s participation in driving the rise in

PG of esgGFP>Pex5-i midguts. We performed genetic interac-

tion by introducing in esgGFP>Pex5-i the PERK mutant allele



Figure 4. Defects in peroxisomal meta-

bolism in progenitor cells activate the

EIF2a/Xbp1/ERp60 branch of the UPR and

increase progenitors

(A) Representative agarose gel image showing

amplicons detecting unspliced and spliced Xbp1

transcript. The representative gel indicates a

decrease in full-length Xbp1 transcript and an in-

crease in the short-spliced variant of Xbp1 in de-

hydrated (stressed) esgGFP>w1118 and esgGFP>

Pex5-i compared with esgGFP>w1118.

(B and C) The violin plots report the value of the

ratio metric analyses between Xbp1 full-length

versus Xbp1 spliced variant (B) and the ratio

values of the band intensity of Xbp1 spliced variant

versus Rpl23 (C) in the midguts of esgGFP>w1118,

dehydrated esgGFP>w1118, and esgGFP>Pex5-i

flies. n = 3.

(D) Indirect immunofluorescence images showing

P-EIF2-a (red) and esgGFP cells (green) in posterior

midguts of adult esgGFP>w1118 and esgGFP>Pex5-i

flies. Scale bar, 25 mm.

(E) The dot plot represents the number of esgGFP-

cells per ROI in the adult posterior midguts of the

indicated genotypes. n = 25–30.

(F) Representative immunofluorescent images

indicating esgGFP-cells (green) in posterior mid-

guts of esgGFP>w1118, esgGFP>Pex5-i, PerkA and

esgGFP>Pex5-i; PerkA flies. Scale bar, 25 mm.

(G) The dot plot represents the number of esgGFP

cells per ROI in the adult posterior midguts of the

indicated genotypes. n = 10–35.

(H) Representative immunofluorescent images

indicating esgGFP cells (green) in posterior midguts

of esgGFP>w1118, esgGFP>Xbp1OE, esgGFP>Pex5-i,

esgGFP>Xbp1-i; Pex5-i and esgGFP>Pex5-i;

Xbp1OE Scale bar, 25 mm.

(I) The violin plot represents the number of esgGFP-

cells per ROI in the adult posterior midguts of the

indicated genotypes. n = 7–10.

(J) The violin plot reports the relative gene expres-

sion of ERP60 in midguts of esgGFP>w1118 and

esgGFP>Xbp1OE. n = 3. In every image the DNAwas

stainedbyDAPI (blue). Theerrorbars represent thestandarddeviationof themean.Statistical significance in (EandJ)wascalculatedusingunpaired t tests. In contrast,

statistical significance in (B, C, G, and I) was calculated using a one-way ANOVA test. **p < 0.01, *p < 0.05; ns, not significant. See also Figures S5 and S6.
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PERKD to reduce its activity. Fluorescent microscopy analyses

indicated that PERKD heterozygous flies present a higher num-

ber of PG in the midguts, although significantly lower than the

number observed in esgGFP>Pex5-i midguts. However,

PERKD allele in esgGFP>Pex5-i genetic background did not

reduce the number of PG observed in esgGFP>Pex5-i midguts

(Figures 4F and 4G). Since eIF2a phosphorylation in ISCs of tu-

nicamycin-treated flies is associated with increased Xbp1

splicing,89,90 we concluded that activation of eIF2a might be in-

dependent of PERK and converging into the IRE-Xbp1

signaling.

To confirm that the increase in PG number in esgGFP>Pex5-i

midguts is caused by the Xbp1 branch of UPR, which promotes

the upregulation of ERp60, we overexpressed the spliced variant

of Xbp1 in PG cells. Fluorescent microscopy data revealed an in-

crease in PG cells in esgGFP>Xbp1OE compared to what was

observed in control esgGFP>w1118 midguts (Figures 4H and 4I),

and this correlated with higher ERp60 transcript amount in
esgGFP>Xbp1OE compared with control esgGFP>w1118 midguts

(Figure 4J). Interestingly, genetic depletion of Xbp1 in PG of

esgGFP>Pex5-i midguts showed a rescue in PG number close

to the level observed in esgGFP>w1118 midguts (Figures 4H

and 4I).

Finally, we probed for mitochondrial stress response by

measuring the transcript levels of genes that encode

proteins involved inmitophagy (Pink1),91mitochondrial heat shock

proteins (suchashsp22,hsp60c, hsc70),92 andgenes that encode

for proteins that are core metabolic regulators that respond to

mitochondrial stress, such as Sirt193,94 and hnf4.95,96

RT-qPCR analyses did not measure significant changes in

these transcripts in the midguts of the analyzed genotypes

(Figures S6B–S6D). Together, these data show that ERp60 con-

trols intestinal regeneration and is triggered by activation of the

Xbp1 branch of UPR that causes an increase in PG in the mid-

guts under metabolic stress due to defects in peroxisomal ether

phospholipid metabolism.
iScience 28, 111946, March 21, 2025 9
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Figure 5. Upregulation of ERp60 enhances Jak/STAT signaling to increase intestinal progenitor cells in response to peroxisomal metabolic

defects

(A) The violin plot indicates the absolute transcript counts detected by the RNAseq analyses for the reported genes in esgGFP>w1118 and esgGFP>Pex5-i progenitor

cells. n = 3. (B) The violin plot represents the relative gene expression of Sox21A versus Rpl23 used as an internal control in esgGFP>w1118 and esgGFP>Pex5-i

midguts. n = 3. (C) Representative fluorescent images indicating esgGFP-cells in posterior midgut regions of esgGFP>w1118, esgGFP>Pex5-i, esgGFP>DomeDN, and

esgGFP>Pex5-i; esgGFP>DomeDN flies. Scale bar, 20 mm.

(D) The dot plot indicates the number of esgGFP cells per ROI in the posterior midguts of flies of the reported genotypes. n = 10.

(E) Representative fluorescent images indicating esgGFP cells in posterior midgut regions of esgGFP>w1118, esgGFP>Pex5-i, and esgGFP>ERp60OE fed regular

cornmeal food supplied with DMSO (vehicle) or the Jak inhibitor tofacitinib. Scale bar, 20 mm.

(F) The dot plot indicates the number of esgGFP cells per ROI in the posterior midguts of flies of the reported genotypes and under the indicated conditions. n = 15–20.

(G) The violin plot represents the relative gene expression of PDIA3 versus HRPT used as an internal control in WT and Pex5�/� murine intestinal organoid

cultures. In every image, the DNA was stained with DAPI (blue). The error bars represent the standard deviation of the mean. Statistical significance in (A and G)

was calculated using an unpaired t test, statistical significance in (B and D) was calculated using a one-way ANOVA test, and the statistical significance in (F) was

computed using a two-way ANOVA test. ****p < 0.0001, **p < 0.01, *p < 0.05; ns, not significant. See also Figures S5 and S6.
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The increase of PG number in esgGFP>Pex5-i midguts is
driven by the Jak/STAT pathway
Multiple signaling controls PG proliferation/differentiation to pro-

mote intestinal regeneration in Drosophila and mammals. To

elucidate the mechanism by which ERp60 triggers PG prolifera-

tion in response to metabolic stress in ISC and EB, we searched

the transcriptomic data for the expression levels of genes that

are established indicators of activation of the major pathways

involved in the regulation of PG in Drosophila and mammals,97,98

including the EGF, Wnt, Notch, JAK/STAT, Hpo, and IRs path-
10 iScience 28, 111946, March 21, 2025
ways. We looked for the absolute transcript counts in the RNA-

seq analysis. We found that targets of EGFR pathway (pnt,

cdc25 and spi), Wnt (ftz and nkd), IRs (thor), Notch (Su(h)), and

Hpo (dIAP1) were detected in the transcriptomic analyses but

were not upregulated in esgGFP>Pex5-i compared with

esgGFP>w1118 PG (Figures S6E–S6G). On the other hand, the

target transcript of the Jak/Stat pathway Socs36E was upregu-

lated in esgGFP>Pex5-i (Figure 5A), suggesting higher activation

of Jak/Stat pathway in esgGFP>Pex5-i PG (Figure 5A). To confirm

it, we performed RT-qPCR experiments to measure the
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transcript of another characterized downstream target of Jak/

Stat in PG, Sox21A, which is known to regulate their proliferation

in response to stress or damage.99 We found that Sox21A tran-

script is upregulated in esgGFP>Pex5-i and esgGFP>ERp60OE

midguts compared with its amount in control esgGFP>w1118 mid-

guts but is reduced in esgGFP>ERp60-i compared with

esgGFP>w1118, esgGFP>Pex5-I, and esgGFP>ERp60OE midguts

(Figure 5B).

To confirm that Jak/Stat pathway is the major signaling driving

PG increase in esgGFP>Pex5-i, we performed genetic and chem-

ical manipulation of the activating upstream receptor known as

Dome in Drosophila. Dome is activated upon binding to the

ligand Upd3. We found that the level of Upd3 was upregulated

in esgGFP>Pex5-i compared to esgGFP>w1118 in PG cells (Fig-

ure 5A). However, when we tested the amount of Upd3 transcript

in esgGFP>Pex5-i midguts compared to esgGFP>w1118, we

observed no difference, suggesting that the production of

Upd3 and activation of the Jak/STAT signal is cell autonomous

in esgGFP>Pex5-i (Figure S6H). Of note, when we measured the

amount of Upd3 mRNA in esgGFP>ERp60-i compared with

esgGFP>w1118 midguts, we recorded a significantly high expres-

sion of Upd3 (Figure S6I), suggesting that depletion of ERp60 in

PG leads to release of inflammatory and proliferative signaling in

the midgut.

We overexpressed the dominant negative allele for Dome in

PG and observed that esgGFP>DomeDN had a PG number similar

to that observed in esgGFP>w1118. However, when we overex-

pressed this allele in esgGFP>Pex5-i, we measured a significant

reduction in PG number in the midguts of esgGFP>Pex5-i;

DomeDN (Figures 5C and 5D). We then treated flies with an es-

tablished inhibitor of Jak, tofacitinib,100,101 and found a reduction

in PG number in esgGFP>Pex5-i and esgGFP>ERp60OE similar to

what was observed in esgGFP>w1118 midguts (Figures 5E and

5F). We concluded that the JAK/STAT pathway mediated the in-

crease in PG proliferation triggered by peroxisomal dysfunction

and ERp60 activation in midguts. Of note, in mammals, the or-

tholog of ERp60, PDIA3, is linked to hepatocellular carcinoma

progression,48 suggesting a connection between PDIA3/ERp60

and proliferative pathways.

Interestingly, RT-qPCR analyses on homozygous mutant

Pex5�/�-derived murine intestinal organoids show a significant

upregulation of PDIA3 compared with its expression in organo-

ids derived from wild-type (WT) small intestines (Figure 5G).

esgGFP>Pex5-i and esgGFP>ERp60OE males have
compromised barrier function and reduced lifespan
To determine whether the increase in PG found in esgGFP>Pex5-i

and esgGFP>ERp60OE affects animal physiology, we performed a

survival assay of esgGFP>w1118, esgGFP>Pex5-i, and esgGFP>ER-

p60OEmales and females. We recorded sex-specific results. The

esgGFP>Pex5-i and esgGFP>ERp60OE males started to die faster

than esgGFP>w1118 around 12 days post-eclosion, and they

continued to die faster, and at 23 and 20 days post-eclosion,

respectively, all the flies were dead, whereas 70% of

esgGFP>w1118 control flies were still alive (Figure 6A). On the con-

trary, esgGFP>w1118, esgGFP>Pex5-i, and esgGFP>ERp60OE fe-

males presented similar survival rates (Figure 6B). On the note,

esgGFP>Pex5-i seemed to have a higher survival rate when
compared with esgGFP>w1118 and esgGFP>ERp60OE from day

10–20 post-eclosion; however, this improvement in survival

was not statistically significant (Figure 6B). To understand

whether the reduction in survival observed in esgGFP>Pex5-i

and esgGFP>ERp60OE males was caused by damage to the in-

testinal epithelial barrier, we used the Smurf assay102 to assess

the loss/reduction of intestinal barrier function in esgGFP>w1118,

esgGFP>Pex5-i, and esgGFP>ERp60OE males and females at

20 days post-eclosion. In the assay, the permeability is detected

by a nonabsorbable blue food dye outside the digestive tract af-

ter feeding, referred to as Smurf.102,103 Both male and female

esgGFP>w1118 flies showed blue-colored food retained in the in-

testine,whereas esgGFP>Pex5-i and esgGFP>ERp60OE male flies

showed blue dye throughout the abdomen (Figures 6C and 6D).

Differently, esgGFP>Pex5-i and esgGFP>ERp60OE females

showed the blue-colored food retained in the intestine similarly

to esgGFP>w1118 flies (Figures 6C and 6D). The esgGFP>w1118

flies fed for 24 h with sucrose in 2% SDS solution to trigger

epithelial barrier damage were used as a positive control

for increased permeability and exhibited the blue dye

throughout their body (Figure 6D). In conclusion, esgGFP>Pex5-

i and esgGFP>ERp60OE males were partial ‘‘Smurfs,’’ indicating

that the barrier function of the intestinal epithelium was compro-

mised in flies with dysfunctional peroxisomes or high expression

of ERp60 in the PG. Downregulation of ERp60 in esgGFP>Pex5-i

rescued the intestinal barrier function in males compared with

esgGFP>Pex5-i males but did not impact gut permeability

in esgGFP>Pex5-i females (Figures 6E and 6F). Additionally,

esgGFP>Pex5-i; ERp60-i males showed a survival rate similar to

esgGFP>w1118 flies (Figures 6G and 6H). Interestingly, the treat-

ment of esgGFP>Pex5-i males with batyl alcohol rescues the

epithelial barrier function defects (Figures S7A and S7B) and re-

duces ERp60 upregulation in the gut of male and female

esgGFP>Pex5-i (Figure S7C), correlating PG number to ether lipid

cellular amount and barrier function in male flies.

Thus, alteration of peroxisomal ether lipid metabolism and

activation of ERp60 as a consequence of Xbp1 signaling of ER

stress response in PG compromises intestinal epithelial barrier

function in adult male Drosophila and affects lifespan. Overall,

our study identified a gene important for ISC maintenance

and healthy regeneration of the intestinal epithelium in physio-

logical conditions and under lipid-mediated metabolic stress

(Figure 7A).

DISCUSSION

The role ofmetabolism in intestinal homeostasis is emerging as an

important area of investigation to identify pathways involved in

epithelial regeneration and function15 and better understand how

the already identified signaling6,7,12 is regulated bymetabolic shift.

Metabolism controls cellular function and can produce

products that act as signaling molecules regulating various

cellular and tissue functions.15,18,22 Recent studies have high-

lighted the importance of mitochondrial metabolic pathways in

ISC homeostasis,15 attracting interest in the importance

of different organelles and their metabolisms in maintaining in-

testinal epithelial regeneration.25 In our study, we define the

importance of peroxisome ether phospholipid metabolism in
iScience 28, 111946, March 21, 2025 11



Figure 6. Upregulation of ERp60 leads to

failure in epithelial barrier function and re-

duces survival in males

(A) Survival of esgGFP>w1118, esgGFP>Pex5-i, and

esgGFP>ERp60OE male flies.

(B) Survival of esgGFP>w1118, esgGFP>Pex5-i, and

esgGFP>ERp60OE female flies. n = 100 flies per

genotype.

(C) The bar graph indicates the percentage of dark

blue area divided by the total abdomen area.

n = 20–30 flies per genotype.

(D) Representative picture of the Smurf assay on

20-day-old female (top) or male (bottom) flies.

Scale bar, 500 mm.

(E) The bar graph indicates the percentage of dark

blue area divided by the total abdomen area.

n = 10 flies per genotype.

(F) Representative picture of the Smurf assay on

15- to 20-day-old female (top) or male (bottom)

flies. Scale bar, 500 mm.

(G) Survival of esgGFP>w1118, esgGFP>Pex5-i,

esgGFP>ERp60-i, and esgGFP>Pex5-i;ERp60-i

male flies.

(H) Survival of esgGFP>w1118, esgGFP>Pex5-i,

esgGFP>ERp60-i, and esgGFP>Pex5-i;ERp60-i fe-

male flies. n = 100 flies per genotype. Significance

was determined using the Kaplan Meier and log-

rank test in (A, B, G, and H). A one-way ANOVA test

was used in (C and E). ****p < 0.0001; ***p < 0.001;

*p < 0.05; ns, not significant. See also Figure S7.
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regulating PG homeostasis and intestinal health. We identified

the ER as a sensor of lipid dysfunction in PG, which activates

the UPR to promote ISC proliferation and control epithelial

regeneration.

Ether phospholipids are essential components of the plasma

and organelle membranes, and alteration in their metabolism

can affect signaling pathways.33,76 Moreover, ether lipids are

also antioxidants and contribute to maintaining a healthy oxida-

tive status in cells. A drop in ether lipids affects other essential

membrane lipids, such as phosphatidylcholine (PC) and phos-

phatidyl ethanolamine (PE). This impacts the PC:PE ratio and af-

fects membrane function and cellular signaling, leading to cell

death,77,104 and is linked to many pathological conditions.77,82,83

In agreement with previous reports,76 we found that ether PC

and ether PE as well as regular PC and PE and PC:PE ratios

changed in esgGFP>Pex5-i midguts compared to what was

observed in control midguts.
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Ether lipids synthesis occurs between

peroxisome and ER. We found that the

depletion of a key enzyme of peroxisomal

ether phospholipid metabolism, GNPAT,

in PG yields a phenocopy of the increase

in PG number observed in esgGFP>Pex5-i

midguts. Activation of the GNPAT cata-

lyzes the conversion of dihydroxyacetone

phosphate (DHAP)105 and acyl-CoA into

CoA and acyl-DHAP, which is then trans-

ferred to the ER to produce the ether

phospholipids.27 Dietary treatment of
3-day-old esgGFP>w1118 and esgGFP>Pex5-i flies with an acyl-

DHAP, 1-O-Octadecyl-rac-glycerol (batyl alcohol) restored the

number of PG in esgGFP>Pex5-i flies to numbers observed in

control midguts, suggesting that ether phospholipids are the

primary regulator of the increase in PG number in esgGFP>

Pex5-i flies.

The ER can sense lipid imbalances in the cell or cell mem-

branes, a state of lipid toxicity that affects proteins and may

cause an accumulation of unfolded protein35,80 that, in turn, ac-

tivates the UPR response.35,78,80,106 Under stress, the ER acti-

vates three distinct signaling pathways to restore homeosta-

sis.41,86 The signaling pathways of UPR are mediated by three

ER-resident proteins: IRE1 (inositol-requiring enzyme 1), PERK

(protein kinase R-like ER kinase), and ATF6 (activating transcrip-

tion factor 6). IRE1 has serine/threonine kinase and RNase

domains in the cytoplasmic region. Upon ER stress, PERK acti-

vation triggers the phosphorylation of the serine 51 residue of



Figure 7. Graphical representation of the results

(A) Alteration of peroxisome biogenesis in PG leads tometabolic dysfunction (right side). Defective peroxisomes cannot process VLCFAs and redox activities and

inhibit ether phospholipids synthesis as they fail to produce the Alkyl-G3P precursors used by the ER to make ether phospholipids. Deficiency in ether phos-

pholipids production triggers EIF2a and Xbp1 activation, which leads to the upregulation of ERp60. High levels of ERp60 directly or indirectly support Jak/Stat-

mediated proliferation of progenitor cells. Question marks on connecting arrows indicate pathways that have not been molecularly defined. The faint blue

arrowhead between Perk and EIF2a denotes a lack of activation of this branch of the pathway in our system.
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eIF2a, resulting in the alleviation of ER stress by attenuating

translation. IRE1 is activated and recognizes the stem-loop

structure of Xbp1 mRNA and induces unconventional splicing.

The spliced Xbp1 mRNA encodes an active transcription factor

that upregulates the expression of UPR target genes, including

ER chaperones, ERAD components, and lipid biosynthetic en-

zymes.84 ER stress also induces the translocation of ATF6

from the ER to the Golgi apparatus, where ATF6 is cleaved.

This proteolytic cleavage produces the N-terminal region of

ATF6, which functions as an active transcription factor and upre-

gulates target genes encoding ER chaperones, ERAD compo-

nents, and XBP1.When ER stress is not resolved, it might induce

autophagy and cellular death.

We demonstrated that a drop in ether phospholipids caused

by a dysfunction peroxisomal metabolism triggers Xbp1 splicing
and the induction of the ERAD and chaperone gene expression.

Particularly, we identify ERp60, the Drosophila ortholog of pro-

tein disulfate isomerase A3 (PDIA3), and target of Xbp1, as an

essential regulator of PG number.We found that ERp60 supports

the Upd3/Dome/STAT-dependent accumulation of PG, indi-

cating that ERp60 is a newly identified regulator of Jak/STAT-

mediated regulation of ISC homeostasis. Moreover, depletion

of ERp60 in developing flies or adult life leads to loss of PG

and shortening of the intestinal tract. Interestingly, PDIA3 was

found to be upregulated in hepatocellular carcinoma48 in

mammals.

ERp60 is a stress response protein that aids the correct folding

of proteins. It is mainly located in the ER, which helps the UPR

response to relieve ER stress. However, it has also been found

in the nucleus and at the plasma membrane, supporting the
iScience 28, 111946, March 21, 2025 13
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idea that its disulfate isomerase activity regulates many proteins

during various cellular signaling, including STA3 activity, DNA

repair, antigen presentation, cytokine secretion, and promotion

of autophagy.45,47,48

Here, we propose a model where the ether lipid metabolism-

ER stress-ERp60 axis is a core modulator of ISC homeostasis.

It was reported that peroxisomal dysfunction activates

only the PERK-eIF2a of UPR in mammals42,43,62,76,107 and

Drosophila.108 Our work demonstrated that peroxisomal lipid

dysfunction in ISC and EB triggers the activation of the Xbp1

branch of the stress response and triggers PG proliferation.

This increase in proliferation improves survival in adult females

but causes damage to the intestinal epithelium and reduces sur-

vival in males. These sex-specific outcomes underline the meta-

bolic difference observed in male and female intestines in

Drosophila109–112 as in mammals.105,113 Interestingly, when we

previously analyzed the survival of combined male and female

esgGFP>Pex5-i versus esgGFP>w1118, we observed no difference

in survival rate in normal conditions and under infection.29 This

highlights the importance of analyzing males and females in

separate assays, as the profound and often opposite differences

in sex-specific responsesmight affect and confound the studies.

Although we found the Xbp1 branch, and not the PERK

branch, of the UPR is the main regulator of ER response tometa-

bolic stress in PG, we detected an increase in phosphorylation of

eIF2a in esgGFP>Pex5-i PG and a consequence reduction in the

transcription of ribosomal genes, which indicates a reduction of

protein synthesis, another event controlled by the UPR, previ-

ously noticed in peroxisome mutant cells.108 The eIF2a phos-

phorylation represents a convergence point of different stress

pathways known as the ‘‘integrated stress response,’’ which is

governed by specific kinases activated by inflammation, viral in-

fections, nutrient deprivation, and heme deficiency.88 Thus, it is

possible that the activation of eIF2a is independent of PERK, but

the eIF2a-induced inhibition of global translation still contributes

to maintaining the intestinal stem cell state.114–116

Previously, another group identified the importance of the

PERK-eIF2a and Xbp1 branches of the UPR as regulators of in-

testinal epithelial regeneration and function in adult flies.37 They

reported that PERK integrates both cell-autonomous and non-

autonomous ER stress stimuli to induce ISC proliferation and

acute regenerative responses. Yet, the chronic engagement of

this response becomes deleterious in aging flies.37 In another

line of research, ER stress is linked to increased inflammatory

conditions and dysbiosis of the commensal bacteria, leading

to high mortality over aging.38,117–119 Increasing UPR by acti-

vating Xbp1-ERAD signaling in ISCs limited ER-stress-associ-

ated signaling in ISCs and may benefit tissue homeostasis.

Here, we added to the role of UPR in intestinal regeneration

and found that Xbp1-ERp60 signaling in PG is activated in young

and old flies upon metabolic stress and triggers a cell-autono-

mous increase in PG. This response affects the survival of males

under metabolic stress. Although ERp60 over-expression and

Pex5 depletion have similar effects on PG cell numbers in female

and male midguts, we observed sex-specific differences in bar-

rier function and lifespan. It has been reported that the regener-

ative capacity of aging guts in females is stronger than in

males,120 and adult male flies with depletion of peroxisomes in
14 iScience 28, 111946, March 21, 2025
enterocytes are more susceptible to epithelial barrier damage

than females.121

In conclusion, our study increases the understanding of how

cellular stress responses of PG coordinate and maintain intesti-

nal epithelial regeneration in response to metabolic alteration.

We identified ERp60 as an unexplored PG survival and prolifer-

ation regulator.

Overall, our study provides insight into peroxisomal signaling,

ether lipids metabolism, ISC homeostasis, and ER stress

signaling in the gut and sheds light on the etiology of pathologies

ranging from inflammatory bowel diseases to colorectal cancers

caused by alteration of epithelial regeneration.
Limitations of the study
In this study, we identified the importance of ether phospholipid

metabolism in intestinal progenitors in maintaining intestinal ho-

meostasis. Additionally, we determined that ERp60, a disulfide

isomerase conserved in mammals,45 responds to defects in

the ether phospholipids to promote epithelial regeneration, add-

ing a player in regulating intestinal epithelial homeostasis. There

are limitations in our study. Although we genetically demon-

strated that ERp60 impacts the Jak/STAT signaling to drive

progenitors’ proliferation, we have not proved if ERp60 acts as

disulfide isomerase directly interacting with Jak or STAT to pro-

mote their activity and trigger proliferation. It was reported that

PDIA3 in human hepatocellular carcinoma regulates STAT3 by

direct interaction.48 Thus, future studies must define the molec-

ular mechanisms by which ERp60 controls Jak/STAT-mediated

proliferation of progenitors in the intestines.

We reported that treatment with batyl alcohol, a peroxisome-

derived intermediate necessary to the ER to complete the ether

phospholipids synthesis, rescues the defects in intestinal epithe-

lial homeostasis; we did not determine which specific ether

phospholipid controls the ER stress response and whether its

deficiency is the direct or indirect cause of UPR response.

More analyses would define the distinct lipid requirement that

controls intestinal epithelial regeneration.
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Deposited data

RNAseq data ncbi accession number This paper Database NCBI: PRJNA1189839

This study

Experimental models:Strains
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Dalhousie University
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Oligonucleotides

See Table S2

Recombinant DNA

pTW-ERp60OE Di Cara Lab

Dalhousie University

This paper

Software and algorithms

Fijii software NA imagej.net (USA), micron.ox.ac.uk

(European mirror)

Prism10 GraphPad https://www.graphpad.com

HISAT2, StringTie, Ballgown and Deseq2 NA Shingleton and Vea112

QIAGEN CLC Genomics Workbench NA https://digitalinsights.qiagen.

com/trial-request

Qiagen GeneGlobe platform Qiagen www.qiagen.com/GeneGlobe
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gsea/index.jsp
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Other

Confocal microscope ZEISS LSM 880 with Airy scan

Costar� 24-Well Flat-Bottom Plate, Tissue

Culture-Treated
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EXPERIMENTAL MODEL AND STUDY PARTICIPANT DETAILS

Drosophila melanogaster
All fly stocks were maintained at either 18�C or 25�C on standard Bloomington cornmeal medium. F1 males and females used for

experiments were moved to 29 �C at larval stage 1 and kept for 3, 10 or 14 days post eclosion, depending on the experiment, before
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being dissected. Males and Females analyzed in the survival assay were moved to 29 �C at larval stage 1 and kept until death. The

initial transcriptomic screen was performed on midguts dissected from 10-day-old flies (100 males and 100 females together to

obtain 200 guts per replicate). QRT-PCR experiments to validate the RNAseq results were performed in 10-day-old flies that were

moved to 29�C as L1 larvae.; males and females were separated for the experiment. All other experiments were performed using

3-10-day-old or 14-old flies. The initial Q-PCR and fluorescence microscopy experiments to validate the results of the RNA screen

and identify gene hits were performed on males and females separated. Follow-up experiments were performed on pooled males

and females when sex-specific differences were not identified. The sex of flies for each experiment is reported in the figures. For

rescue experiments, the parental crosses were set to generate flies carrying two constructs needed to promote RNA-mediated

depletion or overexpression of each gene of interest together with the temperature-sensitive inducible driver (w; esgGal4, tub-

Gal80TS; UAS-GFP), flies carrying individual recombinant construct to manipulate one gene of interest and the temperature-sensitive

inducible driver or only the temperature-sensitive inducible driver; guts from each of these groups were compared in each biological

replicate. For all the other crosses, experimental F1 was compared to F1 of control crosses that were individually set.

Our team generated the pTW-ERp60OE strain for this study. The recombinant DNA was made by first amplifying the cDNA

sequence coding for the ERp60 ERp60-Forward 50- C ACC ATG ATG TGG CGC CTT and ERp60-Reverse 50- TTA GAG CTC GGT

CTT CTT GGG. The amplified fragment was cloned into the pENTR/D-TOPO donor vector (Thermo Fisher) and then transferred to

the Drosophila Gateway destination vector, pTW.

The recombinant DNA was sent to Genome ProLab Sherbrooke, Québec, Canada to generate transgenic flies.

All the strains used in this study are reported in the key resources table.

Ethics approval and consent to participate
Mouse colonies were maintained as stable inbred lines under the Dalhousie University committee for laboratory animals’ institution-

ally approved animal protocol # 24-014, abiding by the standards of the Canadian Council on Animal Care.

Pex5 mutant mice
The Pex5-loxP mouse (B6J.129-Pex5tm1Pec/BaesJ, Jackson Laboratory)122 contains loxP sites flanking exons 11–14 of the Pex5

gene, and deletion of the floxed sequence creates a null allele. The villin-Cre mouse (B6.Cg-Tg(Vil1-cre)1000Gum/J, Jackson Lab-

oratory) carries a Cre recombinase expressed under the control of the villin promoter. This enables targeted spatiotemporally

controlled Pex5 deletion in the gut in the villus and crypt epithelial cells of the small and large intestines. Heterozygous were crossed

to obtain vilCre/VilCre; Pex5�/� mice.

We used 2-day-old male and female mice to grow the organoids.

METHOD DETAILS

Cornmeal diet (CMD)
The CMD food was prepared following the Bloomington stock center recipe (https://bdsc.indiana.edu/information/recipes/

bloomfood.html). The liquid food was then poured into a DrosoFiller (Flystuff 59–168 Droso-filler, Narrow, Genesee Scientific) for

mass dispensing into polypropylene 46 mL housing vials.

High-fat diet (HFD)treatment
Adult 3-day-old flies were fed High-fat food (HFD) for 24 h (h). HFD was made using a 4:1 ratio of cornmeal food to fat. For 5mL final

volume of HFD food, 4 mL of Cornmeal food was mixed with 750 mL of Coconut oil and 250 mL Erucic acid. The CM food was freshly

prepared as described above and then mixed with the two lipids warmed at 50�C. Ten mL blue food colors were added to the mixture

to monitor the HFD food’s homogeneity and allow the selection of well-fed flies before dissection. The choice of fats was made to

obtain a mixture of Long Chain Fatty Acids (LCFAs) (coconut oil) and Very Long Chain Fatty Acids (VLCFAs) (erucic acid).

1-O-Octadecyl-rac-glycerol treatment
Adult 3-day-old flies were fed CM food supplemented with 1-O-Octadecyl-rac-glycerol (Batyl alcohol) at a final 1 mg/ml concentra-

tion for 4 days at 29�C. As 1-O-Octadecyl-rac-glycerol is soluble in 5%Chloroform, we analyzed the flies on CM food supplemented

with 5% Chloroform as a control.

Niacin treatment
Adult 3-day-old flies were fed CM food supplemented with niacin (nicotinic acid) 0.100g/100 mL (N4126, Sigma-Aldrich) at every life

cycle stage and tested 7 days after eclosion.

Tofacitinib treatment
Adult 5-day-old flies were fed CM food supplemented with 18 mM Tofacitinib for 2 days days at 29�C. As Tofacitinib is soluble in

DMSO, we analyzed the flies on CM food supplemented with DMSO as a control.
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Survival assay

To generate survival curves for flies with knockdowns of Xbp1, ERp60, or Pex5 in PG (esg-driven knockdown) and relative control

(esgGFP>w1118), adult male and female flies were collected and kept for 48 h at 25�C to mate. On the third day, male and female

flies were anesthetized with CO2 and divided by sex in the group on regular CM food. Survival experiments were done at 29�Cwith 20

flies for each group. Surviving flies were transferred daily to fresh vials and counted.

Measurement of H2O2

For H2O2 measurement, 20 guts from flies of each genotype or under specific conditions were homogenized in PBS and clarified by

centrifugation. H2O2 amounts in the resultant supernatants were measured using the Amplex Red Hydrogen Peroxide/Peroxidase

Assay Kit (Thermo Fisher) and normalized to protein amounts. Protein amounts were measured using a Qubit II fluorimeter (Thermo

Fisher). Experiments were done in triplicate.

Free fatty acids (FFA) quantification
For FFA measurement, 20 guts from flies of each genotype or under specific conditions were homogenized in PBS and clarified by

centrifugation. FFA quantification was done using the Free Fatty Assay Kit (Sigma) following the manufacturers’ protocols. Lipid

amounts were normalized to protein amount. The protein concentration in the lysates was determined using the Qubit Protein Assay

Kit (Thermo Fisher), according to the manufacturer’s instructions.

Progenitors (ISC and EB) isolation, RNA extraction and library preparation for RNA sequencing transcriptomic
Intestinal stem cell isolation by fluorescence-activated cell sorting (FACS) was adapted from the published protocol article by Dutta

et al., 2013. In brief, three biological replicates consisting of 200 fly guts per replicate were dissected in PBS-1X and then immediately

transferred into a 1.5-mL microcentrifuge tube containing ice-cold diethylpyrocarbonate (DEPC)-treated water-PBS (400 mL).

Dissected midguts were then dissociated with 100 mL elastase solution (1 mg/mL final concentration) and incubated for 1 h at

27�C in a heating block with shaking at 34 3 g. Dissociated cells were centrifuged for 20 min at 300 3 g, at 4�C, and the pellets

were resuspended in 500 mL fresh PBS-DEPC for sorting. 1 mL of 1 mg/mL propidium iodide was added, and then dissociated cells

were filtered using 25-mm filters to remove clumps. Cell suspension was then FACS sorted. GFP+ cells from the esgGFP>w1118 and

w1118 (negative control no GFP) midguts flies were sorted out first to set the fluorescence gate. For each of the three biological rep-

licates, about 40,000 GFP+ cells were sorted. RNA was isolated from the FACS-sorted GFP+ cells using a Direct-zol RNA Microprep

kit, followed by library preparation using the QIAseq UPX30 transcriptome for next-generation sequencing paired to the QIAseq UPX

30 trans. 12 (Index 48). Libraries were pooled and quantified using QIAseq library Quant Assay kit and analyzed on a bioanalyzer (Agi-

lent). Libraries were sent to Center d’expertise et de services Génome Québec, where they were sequenced using NovaSeq6000 SP

flowcell using custom primers from the QIAseq UPX3 transcriptome kit.

RNA sequencing analyses
The differentially expressed genes were determined using three different pipelines, and the results were compared. The fastQ files

were analyzed using.

(1) the Qiagen GeneGlobe platform (www.qiagen.com/GeneGlobe).

(2) The QIAGEN CLC Genomics Workbench.

(3) The HISAT2, StringTie, Ballgown and Deseq2 pipeline, as reported previously.123

RNA-seq enrichment pathway
Gene Set Enrichment Analysis (GSEA) was performed using GSEA v4.1.0 to identify biological processes, cellular components, and

KEGG pathways significantly altered in the intestinal progenitors of esgGFP>Pex5-i versus esgGFP>w1118 midguts. The gene interac-

tion network of GSEA results was generated and manually curated to remove redundant and uninformative nodes using Cytoscape

v3.8.2.73.

Total RNA extraction, cDNA synthesis and QRT-PCR
Midguts from adult flies were dissected in Phosphate-buffered saline (PBS-1X), transferred to TRIzol reagent, and snap-frozen in dry

ice. Total RNA was extracted using the Direct-zol RNA Microprep kit following the manufacturer’s protocol. RNA was reverse tran-

scribed using the High-capacity Script cDNA Synthesis kit, and the synthesized cDNA was amplified by QPCR using the SYBR-

Green PCR master mix using a QuantStudio 6 Flex qPCR machine (Applied Biosystems, Thermo Fisher Scientific). Samples were

normalized to Rpl23 gene expression, the relative quantification methods, and primer efficiency. Primer sequences used in real-

time qPCR are presented in the key resources table. In some experiments, data were represented as % of relative expression

compared to the control condition.
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RT-PCR to test XBp1 splicing
Total RNA was isolated from esgGFP>Pex5-i versus esgGFP>w1118 midguts. One microgramme of isolated RNA using Direct-zol RNA

Microprep kit was reverse transcribed using the High-capacity Script cDNA Synthesis kit. The synthesized cDNA was amplified by

PCR using the 2X Q5master mix. The PCR products were detected on 2% agarose gel by electrophoresis. The band’s intensity ratio

indicated the differentially spliced Xbp1 mRNA (220 bp) to the inactive spliced form of Xbp1 mRNA (240 bp) was calculated in each

sample to determine the amount of active Xbp1 per sample and condition. Rpl23 was used as a loading control to calculate the

band’s intensity ratio of the spliced Xbp1 to Rpl23. The bands’ intensity was calculated using the open-source FIJI software package.

Immunofluorescence and confocal microscopy
Guts were fixed in 4% paraformaldehyde in PBS-1x for 45 min, washed three times (15 min each) in PBS-T (PBS containing 0.05%

Triton X-100), and incubated for 1 h at room temperature in blocking solution (5% Bovine fetal serum in PBS-T) and incubated with

primary antibody in blocking solution for 16 h at 4�C. Rabbit anti-P-eIF2a antibody was used at 1:250 dilution, mouse anti-P-H3,

mouse anti-Prospero and mouse anti-Delta were used at 1:100. Tissues were then washed three times in PBS-T and incubated in

the appropriate Alexa Fluor secondary 555-anti rabbit IgG or 555-anti mouse IgG antibodies at 1:1000 dilution and 40,6-diami-

dino-2-phenylindole (DAPI) at 1:1000 dilution. After three washes in PBST, and one last wash in PBS-1x, guts were mounted in

Prolong-Gold Antifade Reagent and imaged using a 203 or a 403 plan-Apochromat lens mounted onto an Axio-Observer M1 mi-

croscope (Zeiss).

Post-imaging analysis was performed using the open-source Fijii software package or ZEN software. The analyzed region of in-

terest (ROI region) represents a 425.103 425.10 micron in the posterior midguts. Multiple ROI regions were taken to cover the entire

posterior midgut and the average value per posterior midgut was reported as a single dot/fly. At least ten guts were imaged for every

genotype and/or condition in every experiment, and representative images were chosen for each experiment.

Detection of apoptosis assay
In Situ cell death detection kit, TMR red assay was used for the detection and quantification of apoptotic cell death in midguts. The

reaction preferentially labels DNA strand breaks generated during apoptosis. 10 mL of Enzyme Solution were added to 90 mL Label

Solution to obtain 100 mL TUNEL reaction mixture (working solution). The TUNEL reaction mixture should be prepared immediately

and kept on ice until use.Midguts were dissected, in 4%paraformaldehyde in PBS-1x for 45min, washed three times (15min each) in

PBS-T (PBS containing 0.05% Triton X-100), then incubated with the TMR working solution for 30 min in the dark with slow shaking.

Guts were then washed 2 times (15 min each) in PBS-T then incubated with DAPI at 1:1000 dilution for 45 min. After three washes in

PBST and one wash with PBS-1X, guts were mounted in Prolong-Gold Antifade Reagent (Thermo Fisher) and imaged using a 203

objective mounted onto an Axio-Observer M1 microscope (Zeiss).

Smurf assay
10-day-old female and male flies were moved from regular cornmeal food to vials containing a vial plug saturated with a solution of

5% sucrose in PBS plus blue food coloring. After 48 h the flies were imaged with a 12.43magnification on a SteREO Discovery V20

Microscope, equipped with an Axiocam 208 color camera (Zeiss). Image analysis was performed in ImageJ.

Lipidomics
Lipid Extraction

Extraction of lipids was carried out using a biphasic solvent system of cold methanol, methyl tert-butyl ether (MTBE), and PBS/wa-

ter124 with some modifications. In a randomized sequence, to each sample was added 225 mL MeOH with internal standards and

188 mL PBS. Samples were homogenized for 30 s, transferred to 1.5 mL Eppendorf tubes containing 750 mL MTBE, and then incu-

bated on ice with occasional vortexing for 1 h. Following incubation, samples were centrifuged at 15,000 3 g for 10 min at 4�C. The
organic (upper) layer was collected, and the aqueous (lower) layer was re-extracted with 1 mL of 10:3:2.5 (v/v/v) MTBE/MeOH/dd-

H2O, briefly vortexed, incubated at RT, and centrifuged at 15,000 3 g for 10 min at 4�C. Upper phases were combined and evap-

orated to dryness under speedvac. Lipid extracts were reconstituted in 400 mL of 4:1:1 (v/v/v) IPA/ACN/water and transferred to an

LC-MS vial for analysis. Concurrently, process blank samples were prepared and pooled quality control (QC) samples were prepared

by taking equal volumes (150 mL) from each sample after final resuspension.

Mass spectrometry analysis of samples

Lipid extracts were separated on an Acquity UPLC CSH C18 column (2.13 100 mm; 1.7 mm) coupled to an Acquity UPLC CSH C18

VanGuard precolumn (5 3 2.1 mm; 1.7 mm) (Waters, Milford, MA) maintained at 65�C connected to an Agilent HiP 1290 Sampler,

Agilent 1290 Infinity pump, and Agilent 6545 Accurate Mass Q-TOF dual AJS-ESI mass spectrometer (Agilent Technologies, Santa

Clara, CA). Samples were analyzed in a randomized order in both positive and negative ionization modes in separate experiments

acquiring with the scan range m/z 100–1700. For positive mode, the source gas temperature was set to 225�C, with a drying gas

flow of 11 L/min, nebulizer pressure of 40 psig, sheath gas temp of 350�C and sheath gas flow of 11 L/min. VCap voltage is set at

3500 V, nozzle voltage 500V, fragmentor at 110 V, skimmer at 85 V and octopole RF peak at 750 V. For negative mode, the source

gas temperature was set to 300�C, with a drying gas flow of 11 L/min, a nebulizer pressure of 30 psig, sheath gas temp of 350�C and

sheath gas flow 11 L/min. VCap voltage was set at 3500 V, nozzle voltage 75 V, fragmentor at 175 V, skimmer at 75 V and octopole RF
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peak at 750 V. Mobile phase A consisted of ACN:H2O (60:40, v/v) in 10 mM ammonium formate and 0.1% formic acid, and mobile

phase B consisted of IPA:ACN:H2O (90:9:1, v/v/v) in 10 mM ammonium formate and 0.1% formic acid. For negative mode analysis

the modifiers were changed to 10 mM ammonium acetate. The chromatography gradient for both positive and negative modes

started at 15% mobile phase B then increased to 30% B over 2.4 min, it then increased to 48% B from 2.4–3.0 min, then increased

to 82% B from 3–13.2 min, then increased to 99% B from 13.2–13.8 min where it’s held until 16.7 min and then returned to the initial

conditions and equilibrated for 5 min. Flow was 0.4 mL/min throughout, with injection volumes of 7 mL for positive and 10 mL negative

mode. Tandem mass spectrometry was conducted using iterative exclusion, the same LC gradient at collision energies of 20 V and

27.5 V in positive and negative modes, respectively.

Analysis of mass spectrometry data

For data processing, Agilent MassHunter (MH) Workstation and software packages MHQualitiative and MHQuantitative were used.

The pooled QC (n = 8) and process blank (n = 4) were injected throughout the sample queue to ensure the reliability of acquired lip-

idomics data. For lipid annotation, accurate mass and MS/MS matching was used with the Agilent Lipid Annotator library and

LipidMatch (See Ref below). Results from the positive and negative ionization modes from Lipid Annotator were merged based

on the class of lipid identified. Data exported from MH Quantitative was evaluated using Excel where initial lipid targets are parsed

based on the following criteria. Only lipids with relative standard deviations (RSD) less than 30% in QC samples are used for data

analysis. Additionally, only lipids with background AUC counts in process blanks that are less than 30%of QC are used for data anal-

ysis. The parsed excel data tables are normalized based on the ratio to class-specific internal standards, then to tissuemass and sum

prior to statistical analysis.125

Statistical analysis

Multivariate analysis was performed using MetaboAnalyst. Statistical models were created for the normalized data after normalizing

to sum, logarithmic transformation (base 10) and Pareto scaling.126

Mouse intestinal organoids culture
The protocol for crypt isolation is adapted from the one available at the STEMCELL Technologies (Vancouver, BC) Website. All the

solutions, except for the Intesticult Organoid Growth Medium (STEMCELL Technologies), were kept on ice and used cold. On day 0,

the pups were sacrificed through decapitation, and the small and large intestines were harvested in cold sterile 1X PBS. After 2

washes with cold 1X PBS, the tissue was minced in the smallest pieces possible with sterile scissors inside the tube. The pieces

were washed 3 more times and incubated with 10 mL of Gentle Cell Dissociation Reagent (STEMCELL Technologies) for 15 min

at RT on a rocking platform. After washing with 1X PBS plus 0.1% BSA the fragments were passed through a 70 mm filter, and

then washed again in DMEM/F-12 with 15 mM HEPES (STEMCELL Technologies). The crypts were resuspended in a cold solution

made of ½ Growth Factor Reduced Matrigel (Corning Inc., Corning, NY, USA) and ½ DMEM/F-12 (STEMCELL Technologies) and

seeded in 50 mL drops in a pre-warmed 24-well plate (Corning Inc.). The seeding concentration was 200 crypts/dome. The plate

was incubated for 10 min at 37�C to let the Matrigel polymerize, and then the pre-warmed complete Intesticult Organoid Growth Me-

dium was added, 500 mL per well. Media changes were performed every two days, and organoids were passaged approximately

once a week at a 1:4-1:6 ratio.

QUANTIFICATION AND STATISTICAL ANALYSIS

Statistical analyses
All statistical analyses were done in Prism (Graph-Pad). All data were assessed for normality using Shapiro–Wilk checks before

running statistical tests. Statistical significance was determined using a two-tailed Student’s t test, one-way analysis of variance

(ANOVA), two-way ANOVA, or using the Kaplan–Meier log rank for survival assays. Significance is shown in figures as ns; *p %

0.05; **p % 0.01; ***p % 0.001; ****p % 0.0001. The statistical details of experiments can be found, including the statistical tests

used, the exact value of n, and dispersion and precision measures are reported in the figure legends.

Quantification of agarose gel band signals
To determine the density of bands on a agarose gel, we used FIJI using the protocol reported in (https://imagej.nih.gov/ij/docs/

menus/analyze.html#gels). In brief.

(1) File>Open

(2) The gel analysis routine requires the image to be a gray-scale image. To convert to grayscale, go to Image>Type>8-bit.

(3) Use the rectangular selection tool to outline the first lane. The rectangle should be tall and narrow to enclose a single road.

(4) SelectAnalyze>Gels>SelectFirstLane(orpress"100),andthelanewillbeoutlinedand"Lane1selected"displayedinthestatus bar.

(5) Move the rectangular selection right to the next lane and select Analyze>Gels>Select Next Lane (or press "200). The desig-

nated lane is outlined and labeled, and "Lane n selected" is displayed in the status bar.

(6) Repeat the previous step for each remaining lane.

(7) Select Analyze>Gels>Plot Lanes (or press "300) to generate the lane profile plots.

(8) Use the straight-line selection tool to draw baselines and drop lines so that each peak of interest defines a closed area.
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(9) For each peak, measure the size by clicking inside with the wand tool.

(10) Select Analyze>Gels>Label Peaks to label each measured peak with its size as a percent of the total length of the measured

peaks.

(11) The values from the Results window can be moved to an Excel spreadsheet program to calculate the ratio between the den-

sity of a protein of interest over the density of a protein used as loading control for each sample and treatment.

Quantification of GFP+ cells in midguts
The number of cells expressingGFP or positive for Delta antibody or TUNEL staining were counted using Fiji’s. The quantificationwas

done by manually counting the number of positive-stained cells within a region of Interest field (ROI) fixed across the samples and

reported as the number of cells/ROI.

Quantification of fluorescence signals
To determine the intensity of the defined protein within the cell.

(1) Open the ImageJ software.

(2) Click the ‘File’ tab, then click ‘Open’ to open the file you want to quantitate. A window will pop up named ‘Bio-Format Import

Options.’

(3) ‘Hyperstack’ and ‘Colorized’ options allow independent analysis of each fluorescent channel collected in the original exper-

iment.

(4) Click on the Split channels to obtain three separated windows one for each of the three color channels so that the quantitation

of each fluorescent channel can be performed separately.

(5) Hit ‘OK’ at the bottom right of the window to proceed to the next quantification step.

(6) Click on the ‘Freehand selections’ button and then use the drawing pen to circle the area of the cell to be quantitated.

(7) Click the ‘Analyze’ button to select the ‘Measure’ option. A window will then pop up named ‘Results,’ which includes several

measurements that the software made on the chosen area, including Median Intensity. Copy the median value in an Excel

sheet for each gut measured. Measure at least 10 guts.

It is preferable to subtract the background Median Fluorescence Intensity (MFI) from the MFI of a region of interest (ROI) while

analyzing images since the background of an image might affect the MFI quantitation.

(1) Repeat step 7 to select and measure a non-fluorescent area of the same image. MFI of that non-fluorescent area/negative

control image is then subtracted from the tissue area MFI.

(2) Calculate the final MFI = MFI of an ROI – MFI of Background.

(3) Copy and paste the value in Prism to represent results in a diagram and carry out our statistical analyses.
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